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This work is licensed under a Creative Commons Attribution-ShareAlike 

2.5 License. 
 

Endnote Workbook with exercises 
 
EndNote is software which enables you to:  
 

• Maintain a database (called a Library) of references 

• Import references from other databases 

• Embed references from the database into a word processed document 

• Produce bibliographies in an appropriate style for submission or publication. 
 
The following exercises will take you through the basics of each of these features of EndNote using a 
sample library, which can be searched, sorted and edited and by importing references from external 
databases to create a Library of your own. There is no limit to the number of references you can have 
in an Endnote Library. There is no limit to the number of libraries you can create, as long as you have 
the space to store them.  It is recommended that you keep all the references you cite in your papers in 
one primary library and use the Groups facility to break down your large library into subsets. 
  
These exercises assume you are accessing Endnote X4 on one of the networked PCs on campus e.g. 
from a cluster in the Learning Centre or Main Library, and working with Microsoft Office 2007 software.  
 
 

N.B. Remember to back up your work at regular intervals! 

 
 
 
1.  MANAGING AN ENDNOTE LIBRARY 
 
 
1.1.  Sorting the sample library (Paleo.enl) 

 
EndNote automatically sorts alphabetically by author, but you can change the way records are sorted. 
 

• Start EndNote (Start, Programs, ITSApplications, EndNote, EndNote Program) 
 

• Open the Paleo database (File, Open, Open Library, (Local Apps:E, isapps, EndNote, 
Examples, Paleo.enl)) 

 

• Open the Paleo database  
 

• To do a simple sort by Author, Year or Title, click the appropriate headings.  One click sorts 
in ascending order, two clicks sort in descending order. 

 
NB:  If you want to find the Paleo Library on your computer at home/work (File, Open, Open Library, 
(C:\programs\endnoteX4 and then the examples folder) 
 
 
1.2.  Changing the display (Paleo.enl) 
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You can determine how you want the items in your library to display.  Click on Edit from the toolbar 
and select Preferences, then Display Fields.  Here you can select what you want to display in each 
of the columns. For example, change column 5 to display Reference Type instead of URL.  
You can display up to 8 columns of information or you can select do not display instead of a field name 
if you want to display fewer than 8 columns.   
 
1.3.  Using Groups 

 
On the left-hand side of the Endnote Library display screen is a column called My Groups.  Groups 
make it easy to break a large library into subsets for later viewing.  A group simply points to a subset of 
references that already exist in the library. 
 

1.3.1.  Displaying and Hiding Groups 
 
You can decide to either display or hide the group panel.  To hide the group panel: 

• In Endnote, click on the Groups from the toolbar 

• Select Hide Groups from the dropdown menu 

• If you want to display groups, if already hidden, click on Groups and select Show Groups 
 

1.3.2.  Different group types 
 
There are different types of groups.  Permanent Groups; Temporary Groups; My Groups; Smart 
Groups; Online Search 
  

• Permanent Groups.  All References, Unfiled and Trash are permanent groups, which you 
cannot remove or rename.  All References displays every reference in the library.  Unfiled 
displays those references that are not part of a custom group (and, optionally, smart groups). 
Trash in a holding place for references you have removed from the library, but have not yet 
permanently discarded by emptying the Trash. 

 

• Temporary Groups.  These include Duplicate References, Copied References, Full Text, 
Imported References and Search Results.  These temporary groups are deleted when you 
close the library, but the references remain in the library 

 

• My Groups.  You can create your own groups.  This is a useful facility and will help you to 
organize a large library into useful subsets. 

 

• My Smart Groups.  These groups work with search strategies. Smart groups are dynamically 
updated as you add references to and edit references in the library. 

 

• Online Search.  Groups allow you to easily initiate a search of a favourite online database 
and quickly view the latest download 

 
 

1.3.3.  Using My Groups 
 
You can create your own Groups.  You can select references and then add them to a new group, or 
you can create an empty group and then add references to it. 
 
Creating a Custom Group 
You can create My Groups in several ways. 
 

• In Endnote, click on the Groups menu and then choose Create Group, or 

• Right click in the Groups pane of the Library window to display a contextual menu and 
select Create Group, or 

• Select references in a reference list, then click on the Groups menu and choose Add 
References to>Create Custom Group…, My Groups 

 
Enter a group name, which can be from 1 to 255 characters in length.  There are no restrictions on the 
characters you can use in a group name. 
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Adding References to a Group in My Groups 
You can add references to a new or existing custom group at any time. Endnote will automatically 
detect if you try to add the same reference to a group more than once. 

• Start by selecting the references you want to add to the group.  This can be done in several 
ways: 

o Click on an individual reference, or 
o Display a list of references, this can be from All References or from a list of search 

results, go to the Edit menu and choose Select All, or 
o Hold down the SHIFT key to select a range of references, or 
o Hold down the CTRL key to select individual references 

• Then add the references to a group you have created.  You can do this in several ways: 
o Drag and drop the selected references onto an existing custom group name in the left 

pane of the Library window, or 
o From the Groups menu, select Add References To and then select either the name 

of an existing custom group or create group, or 
o Right click on the reference list to display a contextual menu, select Add References 

To, and then select either the name of an existing custom group or create custom 
group. 

 
Deleting References from a Custom Group 
You can delete references from a custom group.  The references will still be in your library and appear 
under All References, they will not appear in that particular custom group. 
 

• To delete a reference from a group under My Groups click on the name of the group 

• A list of references in that group will be displayed.   

• Select the reference(s) you want to delete 

• Delete the references by either pressing the delete key on your keyboard, or from the 
Groups menu, select Remove References from Group  

 

1.3.4.  Using Smart Groups 
 
You can create and save a search strategy and then attach it to a Smart Group.  Every time you 
search for and find references which match your search strategy the references will be added to the 
appropriate Smart Group. 
 
Creating a Smart Group 
 

• From the Groups menu, select Create Smart Group.  A search dialog box appears 
 
 
 
 
 
 
 
 
 
 
 
 

• Name your Smart Group 

• Enter your search strategy and click Create to create a New Smart Group  
 

Image: Screenshot of Endnote, Smart Group dialogue box 

 

Subscription Resource: Yes 

 

Edited: Yes 

 

Amendments: Cropped to only display Smart Group dialogue box 

 

Date: 2010 
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Whenever you do an online search, search your existing references, or import references from another 
source, Endnote will check to see if the references retrieved match the search strategy of the Smart 
Group and if they match, will automatically add them to the appropriate Smart Group. 
 
Editing a Smart Group 
You may have created a Smart Group and then find a bit later on that you want to change the search 
strategy for that group.  You can do this by doing the following: 
 

• Highlight the smart group name in the groups pane 

• From the Groups menu, select Edit Group to display the smart group search dialog.  The 
current search strategy is displayed. 

• Modify the search strategy as needed, and click save   

• The Smart Group updates based on the new search strategy 
 
Deleting References from a Smart Group 

• Click on the Smart Group name in the left-hand pane to display the references for that group 

• Highlight the reference(s) 

• From the Reference menu, select Move References to Trash  

• The references are moved to the Trash group.  The Trash group is a temporary holding 
place.  The references are no longer in your library, and cannot be cited or searched, but they 
have not been irrevocably thrown away yet, either.  If you change your mind, you can drag a 
reference from the Trash back to the All References group to bring it back into the library. 

• When you are certain you no longer want the references you have moved to Trash, select the 
Trash group and then go to the References menu and choose Empty Trash.   

 

N.B. You are limited to 500 my groups and smart groups per library.  Once you reach that limit, 
you must delete a group before you can add a new one.    

 
To find out more about Groups use the help facility within Endnote and search on groups. 
 
1.4.  Modifying reference types (Paleo.enl) 

 
You can modify reference types using the Reference Types table. 
 

• You can change the name of fields within individual reference types – for example you might 
want to create your own Term List and add the name of the Term List to a field  

 

• To do this select Edit, Preferences, Reference Types.  Select Modify reference types.  The 
fields are listed to the side of each reference type. 

 

• Scroll down to the Custom 1 Field and type in Course Name and then OK to return to the 
main Preferences Reference Type window and then OK again to save changes.  If you want 
to change the field across all reference types, click Apply to All Types.  For this exercise click 
Apply to All Types. 

 
 
 
 
 
 
 
 
 
 

 
 

1.5.  Searching for references in an existing library (Paleo.enl) 

 

• Choose Tools from the toolbar, then Search Library.   

• Search for the keyword dinosaur. 

Image: Screenshot of Endnote, Modify Reference Types dialogue box 

 

Subscription Resource: Yes 

 

Edited: Yes 

 

Amendments: Cropped to only display Modify Reference Types dialogue box 

 

Date: 2010 
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• To run the search, click Search. 
 
You can limit your searches to specific fields such as Author, Year or Keywords.  More precise 
searching can be done by searching for words within fields.  You can search for words at the 
beginning of a field or at the end by using “Field begins with/Field ends with” options, which you can 
find under the Contains option.  EndNote allows you to create unlimited length search strings using the 
search operators AND, OR and NOT. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
1.6.  Editing a reference (Paleo.enl) 

 
It is easy to edit a reference, to add more information or correct mistakes. 
 

• Double-click the reference you would like to edit 

• Make some changes 

• Close the reference 
 
 
N.B.  You can also make “global edits”.  For example,  if you spell an author’s name incorrectly and 
use this incorrect spelling in a number of different records you can make changes to these records 
using the global edit facilities.  Global edits can be made via Change Text, available from the Edit 
Menu, or you can use Change and Move Fields, available from the Tools Menu.   More information 
on how to use Change Text and Change and Move Fields can be found from Endnote X4’s online 
help. 
 
 
1.7.  Creating a new library  

 

• Open EndNote 

• Go to File, New and enter your name as the filename for the new database, and click Save. 
 

 
 
 
 
 
 
 
 
 
 

 
 
1.8.  Entering new references manually into a library 

 
It is possible to import records automatically into Endnote from other databases, but there will be times 
when you may need to enter records manually.  

Image: Screenshot of Endnote, Search results  

 

Subscription Resource: Yes 

 

Edited: Yes 

 

Amendments: Cropped to exclude browser window; displays results of a search on ‘dinosaur’ 

in the paleo.enl library  

 

Date: 2010 

 

Image: Screenshot of Endnote, New Reference Library dialogue box 

 

Subscription Resource: Yes 

 

Edited: Yes 

 

Amendments: Cropped to only display dialogue box 

 

Date: 2010 
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• From the toolbar, choose References, New Reference and enter the following reference 
to a journal article.  Remember to change the reference type to Journal Article: 

 
Author  Rayfield, Edward James 

Norman, D.B. 
Horner, ChristopherC. 

Year  2007 
Title  Cranial design and function in a large theropod dinosaur 
Journal  Nature 
Volume  409  
Issue  6 
Pages  33-37  
Keywords Orthopedic biomechanics, Tyrannosaurus Rex, forces, evolution, tissue 

 

• To save your new reference, choose File, Save using the main toolbar or simply close the 
new reference window and the reference will be saved into your new library. 

• To look at your saved reference, double click on the reference.  The reference will be 
displayed in a new window.  Initially, Endnote displays all fields in a reference.  Click Hide 
Empty Fields, to view only those fields that contain data.  

 
 
1.9.  Using Term Lists in an Endnote Library 

 
There are some fields within EndNote which have Term Lists attached to them. The default term lists 
are Authors, Journals, Keywords. Term lists help you to be consistent and maintain the integrity of 
your EndNote library. You can assign terms from your term list(s) and assign them to new references 
in order to make searching more accurate (and often spelling easier!). The Term Lists feature can be 
disabled if you do not wish to activate them. To disable select Edit -  Preferences and click on Term 
Lists to see the options for controlling the way all lists work 
 

• To view your term lists in an existing library select Tools, open Term Lists. 

 

• Select the Term List needed e.g. Keywords Term List 
 
 
 
 
 
 
 
 
 
 
 
 
 

To add a keyword from your keyword term list into an EndNote reference: 

• Open a Reference and place your cursor in the keyword field.  

• Click on Tools - Open Term Lists and select the Term List needed, i.e. Keyword. Double 
click on an appropriate term. This will copy the term into the keyword field. You can also edit 
and add additional terms into this listing. This can be useful if several of you are adding 
references as it creates a consistent list of terms to be used. 

Image: Screenshot of Endnote, Term Lists dialogue box 

 

Subscription Resource: Yes 

 

Edited: Yes 

 

Amendments: Cropped to only display the dialogue box 

 

Date: 2010 
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1.10.  Creating your own Term Lists within Libraries 

 
You can create additional term lists – beyond the three which come complete with the system (Author, 
Journals and Keywords). You may wish to create a Term List for information which is repeated (such 
as module names – if you wish to attach this information to records or you could make a term list for 
publishers’ names). 
  

• Select the Tools, Define Term Lists, click Create List 

• Type a name for the list (for this exercise call it Course Name) and click OK. 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

• The new Term List which you have created now needs to be linked to a particular field or 
fields.  For example, the three predefined term lists (Authors, Journals, Keywords) are already 
linked to their corresponding fields.  Any new term list that you create is not linked to a field 
until you set up the links.  The links between Term Lists and fields are specific to each 
library. 

To link your term list to a field: 

• Click on Link Lists 

• Choose a library from the list at the top of the dialog box 

• The names of the available term lists appear next to the field names with which they are linked 
when you click on the drop down menu.  You may change the links here as necessary by 
choosing a different term list from the drop menu. 

 
 
 
 
 
 
 
 
 
 
      

 
 

• Go to the Custom 1 field and from the drop down menu select your term list e.g. course 
name 

 

• Click OK 
 

• NB: Make sure the field is not one that could be used for other purposes in this Library, 
otherwise the list will not make sense and may have unsuitable terms added to it. Also make 
sure the Field is available in all the Reference Types to be used in the Library.  For this 
example select the “Custom 1” field.  Remember, you have already give the Custom 1 field a 
name “course name” when you did exercise 1.4.  This means the field will appear in your 
library and you will be able to add terms to the field from your newly created term list. 

  

Image: Screenshot of Endnote, Term List name dialogue box 

 

Subscription Resource: Yes 

 

Edited: Yes 

 

Amendments: Cropped to only display the dialogue box 

 

Date: 2010 

 

Image: Screenshot of Endnote, Linking Fields with Term Lists dialogue box 
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• To add Terms to the list, select your term list e.g. Course Name and click the Terms tab and 
select New Term and add a term(s) such as a list of course module numbers and select save 
term. If the term is already in the list the button will be disabled.  After saving the last term, 
select cancel. When all the Terms are displayed, click close to exit 

 

• NB:  If the Library already has References with Terms in the field this list is linked to, you must 
Update this list from the update list option within Lists.  

 
Points to note about Term Lists:- 
 

• Term Lists are stored with the Library 

• 31 Term Lists can be created for each Library and associated with fields 

• No limit to the number of entries in a list 

• Terms can be up to 253 characters long 

• Terms can be copied from one list to another (select, Copy/Paste) 

• Lists can be Imported and Exported 

• Library must be open before lists can be accessed 

  
2.  BUILDING UP AN ENDNOTE LIBRARY 
 
2.1.  Direct importing from databases 

 
Many online services such as Web of Science, Science Direct, EBSCO, Medline and ATLA Religion 
offer the option of directly importing records into EndNote. It is always worth checking if this feature 
exists.  
 

Records imported in this way should always be checked to ensure that they have been carried over 
accurately.  

 

Exercise:  Search Web of Science (Web of Knowledge) and import some references. 

 

• Log in to eLibrary (http://www.elibrary.bham.ac.uk/) and find the Web of Science 
database i.e. once in eLibrary click on the Find Resource tab, then click on the Resource 
Name tab, then type in web of science and click Go.  When the name of the resource is 
displayed click on the link 

 

• Carry out a search on Web of Science 
 

• While still in Web of Science, select a few references by clicking the boxes beside them. 
 

• Click on “Add to Marked List” 
 

• Click on the “Marked List” tab at the top of the page 
 

• Select the fields to include in the output e.g. abstract, keywords.  Author(s), title, source 
are automatically saved. 

 

• Click on “Save to Endnote, Refman, Procite” 
 
 
 

 
 

 
 

 

• Endnote will load up. If it doesn’t, click the export button 
 

• Select your library and import your results into it. 
 

Image: Screenshot of Web of Science results screen, marked list 

 

Subscription Resource: Yes 

 

Edited: Yes 

 

Amendments: Cropped to exclude the browser window 
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The references you have just imported will be displayed on the screen, giving you a chance to 
edit them if you wish.  When you close this screen, the references will be incorporated into 
your main library. 

 
 
 
2.2  Importing references using EndNote filters 

 
Some bibliographic databases do not have an option to import your references directly into EndNote, 
but you can use import filters to import references from more than 50 different bibliographic 
databases.  The import filter helps EndNote format and organise the information correctly, as different 
databases have different ways of organising the data.  You must know which database/service your 
results came from.  
After searching a bibliographic database, make sure you have saved your references in text format 
(.txt).  The records need to be tagged or labelled in separate fields e.g. 
 
AU Rayfield EJ 
TI Cranial design and function in a large theropod dinosaur 
SO Nature 
 
To find out which filters are needed to import references from specific databases, check the I-Cite 
guide http://www.i-cite.bham.ac.uk/filters_for_endnote.shtml.   If the database you want is not 
listed on i-cite go to the Endnote website at http://www.endnote.com/support/enfilters.asp and 
search for the name of the database and download the filter into your Filters Folder in Endnote. 
 

 
Records imported in this way should always be checked to ensure that they have been carried over 
accurately.  
 

 
 

Exercise:  Do a search on Sociological Abstracts CSA, and import the records. 

 

• Please Note: CSA Illumina Cross Searching - Endnote cannot cope with the results of a 
cross-search across more than one of the databases on the CSA platform.  In order to 
download your search results correctly, you need to search each database separately and use 
the appropriate filter when importing into EndNote.   

• Log onto the database in the usual way. Sociological Abstracts can be found on eLibrary 
(www.elibrary.bham.ac.uk).  Once in eLibrary, click on Find Resource and do a Resource 
Name search for Sociological Abstracts (CSA).  When the name of the resource is displayed 
click on the link. 

• Carry out your search and mark the records that are of interest to you.  From the CSA search 
results screen, click on 'Save/Print/Email'.  On the 'Save/Print/Email' screen, select the 
following - 

• Records = Select either Use Marked Records or Use Records from the Current Search. 

• Record Format = Select Full Format 

• Save File Format = PC or MAC (as appropriate) 

• Click on "save" button.  Make sure you save it as a text (.txt) file. 

 

 

 



 
 

Endnote X4 2010  
 

10 

 

Importing your saved text file into EndNote 

• In Endnote, click on File and Import  

• Click on File and find your saved text file  

• In the Import Options field select the filter required for your database e.g. The name of the 
filter for this database is Sociological Abs (CSA). Remember filter names can be found on 
the  i-cite guide www.i-cite.bham.ac.uk.  If the filter is not displayed, select Other Filters and 
look for Sociological Abs (CSA) in the list. Click on Choose. 

• In Duplicates decide whether you wish to keep, save or filter duplicates and click accordingly. 
In the Duplicates box, you can choose to import everything (even if some records already 
appear in your library), or to discard any duplicate records, or to create a separate library of 
duplicates for you to inspect later. 

• In Text Translation click on No Translation.   

• Click on Import. 

• The imported references will be displayed in a separate window.  

 
To return all of your references (including the newly imported ones) to the library display, choose 
Show All References from the References menu. 
 
 
2.3.  Creating a Reference by Importing a Published PDF 

 
Endnote X4 allows you to create records in your library by importing the publisher version of PDFs 
(either single files or a folder of files).  Endnote will extract the bibliographic details and create a 
record/multiple records in your library.   
 
Note:  this feature does not work with scanned pdfs 
 

Exercise:   
 

• Find a PDF of an article and save it onto your desktop 

• Go into Endnote 

• From the file menu, select Import 

• Locate the file or folder to import 

• From the Import Option drop-down menu, select PDF   

• Click Import 
 
2.4.  Using the Connect files to search remote databases  

 
Some databases, such as the British Library Table of Contents service (Zetoc) and COPAC can be 
searched directly from Endnote.   
 

The search interface in EndNote is not as sophisticated and flexible as many offered by database 
services themselves so it may be more effective to save search results from a database and then 
import them into EndNote either using direct export or filters (see 2.2 above). Records imported in this 
way should always be checked to ensure that they have been carried over accurately. 

 
Exercise:  Connect to ZETOC and download some records: 

 

• Start EndNote and open the database you created 
 

• Select Tools and then click online search   
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• From the resulting alphabetical list of resources, select Zetoc (MIMAS), then click on Choose. If 
asked for a password, ignore this and click on OK. 

 

• Use the Search box to carry out a search  
 

• The number of results retrieved will be displayed in a new window.  In EndnoteX4 retrieved 
references are automatically saved in All References, as well as in the Online Search group. You 
can delete any references from the displayed list and this will also delete the reference from the 
main collection. 

 
 
 
 
 
 
 
 
 
 
 
 
 
Dealing with duplicate references in a library  

 

• With the Library window open, click on the All References group to show all references. 

• From the References menu, choose Find Duplicates. 
 
EndNote will display a Find Duplicates dialog, where you can compare duplicates and decide 
which version to keep and which to delete. 

• For each set of duplicates, you have the option to: 

• Click Keep This Record to save that particular reference and throw the other one in 
the Trash. 

• Click Skip to leave both references in the library, intact. They will appear in a 
temporary Duplicate References group, so you can review them later. 

• Click Cancel to stop the Duplicate References operation. All duplicates will appear in 
a temporary Duplicate References group if you wish to review them. 

The older (first entered) reference will always appear in the left column. 

 
 
2.6.  Finding and Attaching Full Text to Endnote References 

 
Once you have populated your Endnote Library with references you might want to add extra 
information or links to some of your references.  For example, you might like to have a PDF or a link to 
the full text attached to a reference. 
 

2.6.1.  Finding and Attaching Full Text to a Reference 
 
Endnote X4 can automatically locate and download full text files by accessing several sources, 
including DOI (Digital Object Identifier), PubMed LinkOut and ISI Web of Knowledge Full Text Links.  
You can also configure the Find Full Text feature to search all the publications to which you have 
access to as a member of the University of Birmingham. 
 

Exercise:  Configuring Find Full Text for the University of Birmingham 

Image: Screenshot of Endnote, Results display 
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Amendments: Cropped to only display the dialogue box 
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• From the Edit menu, select Preferences 

• From the Preferences options, select Find Full Text 

• Tick the check boxes for Open URL 

• Enter the OpenURL Path address:   http://diglib1.bham.ac.uk:3210/sfxlcl3 

• Enter the University of Birmingham’s Authentication URL address: 
http://ezproxy.bham.ac.uk/login  

• Click Apply, then click OK 
 
 
See if you can find the full text of an article by following the instructions below: 
 

• Click on the Reference menu from the tool bar and then select Find Full Text 
 

• Select Authenticate and login with your University Username and Password and click Done. 
 

• Select the reference(s) to which you want to add full text.  You can select a single reference 
or hold down the Ctrl Key to highlight individual references, or use Edit>Select All to select 
an entire group of displayed references. 

 

• Click on the Reference menu from the tool bar and select Find Full Text and the Find Full 
Text option 

 

• Click OK to get past the Copyright notice that pops up  
 

• Endnote begins searching for and downloading full text for the selected references, if the full 
text can be located.  

 
During the searching and downloading process, the selected references appear in a temporary Find 
Full Text Group.  When the operation is completed, the Find Full Text Group will list the number of 
full text articles found and the number that has not been found.  When you close the library, the 
temporary Find Full Text Group is removed.   
 
When a full text file is downloaded and attached to a reference, a file attachment icon i.e. a paper clip 
icon, appears in the File Attachment field for the reference. 
 
The retrieved full text file is saved to the File Attachment field as a relative link i.e. the file itself is 
stored in the current library’s .DATA folder, which accompanies your library.  Relative links are useful if 
you want to share your Endnote library with your colleagues or if you want to move your library to 
another computer.  
 

Note:  If Endnote finds a full text for a reference, but discovers that the reference already has a file 
attachment with the same name, the new copy will also be attached to the reference, but with a 
number appended to the file name.   

 
 
 
3.  PRODUCING BIBLIOGRAPHIES, FOOTNOTES AND EDITING CITATIONS    
 
You should now have two libraries in your EndNote file - Paleo and the new one you have created with 
your own name.  For the following exercises you need to go back into Paleo: 
 
 
3.1. Using Cite while you write to create a bibliography 

 
Cite as you write allows you to work on your document in Word, and to enter citations from EndNote 
as you go along.  
 

• Open Word and write a couple of sentences.   
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• Place the cursor where you would like to insert a reference 
 

• Under the Endnote X4 tab, choose Insert Citation, then Find Citation(s)  
 

• A window will appear, where you can search for the reference that you need to cite. Type 
Baker into the search box and Search. Now click on Insert at the bottom of the window. 

 
The citation will be inserted into your text.  If more than one citation matches, they will be listed in the 
window and you can select the appropriate reference (or more than one by using the Ctrl key). 
 
When you have completed your paper, you can generate a bibliography in a wide variety of output 
styles.  While still in Word, using the Endnote X4 tab, you can change the style by selecting the one 
you want from the drop-down menu marked Style.  A full listing of available styles can be found by 
following the Select Another Style… link. 
 
 
 
 
 
 
 
 
 
 
 
 
Your reference list will be created.  You can change the style of your bibliography as many times as 
you like by following the steps above. 
 
 
3.2. Inserting footnotes 

 
If you would like your references to appear as footnotes (rather than as a list at the end of the 
document) you need to set a preference in the output style you wish to use. 
 

• In EndNote, from the Edit menu, choose Output Styles, Open Style Manager and select the 
name of the style you wish to use.  Click on Edit. 

 

• When the Edit dialogue appears click on the Footnotes - Templates option (at the bottom of 
the scrollable list on the left) to have the following options appear: 

 
 

 
 

 
 
 
 
 
 
 
 

• The Same as Bibliography option does not insert a citation, but the entire reference, as it 
would normally appear in the bibliography of that style. 

 

• The Same as Citations option will format footnote citations in the same style as other in-text 
citations. 

 

• If the style is only going to generate footnotes then you should select the option, Using 
Footnote Format. 

 

Image: Screenshot of Word, Reference list 
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Image: Screenshot of Endnote, Footnotes option 
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• The Include citations in bibliography checkbox allows you to have the citation included in 
the bibliography in addition to appearing in the footnote area. 

 

• N.B. When you have made changes to the template, the amended style will be saved as a 
copy file – e.g. Harvard Copy.  When you come to using it in Word to add your footnotes and 
citations, remember to select the style marked ‘Copy’. 

 

• In ‘Word’ place the cursor where the citation should be inserted. 
 

• From the References tab, select Insert Footnote. The place in the text will be marked with a 
superscript number, while the cursor will go to the foot of the page’ 

 

• From the Endnote X4 tab, click on Insert Citation and Find Citation. Find the reference from 
your Endnote library and click Insert. 

 

• You can place the cursor anywhere within the footnote and add notes or comments to it if you 
wish. 

 
3.3.  Producing a stand-alone bibliography from EndNote 

 
Sometimes you might want to produce a stand-alone bibliography.   
 

• While in EndNote, highlight the references you want to use (hold down Ctrl to highlight multiple 
references). You could instead use the search facility to find references covering a particular 
topic or go to one of your Custom Groups. 

 

• Go to the drop down style menu at the top of the screen and select the style in which you wish 
to present your bibliography.  If the style is not listed, choose Select Another Style and select 
one from there. 
 

• Go to Edit, Copy Formatted  
 

• Either select Print or paste your bibliography into a word document to save and print later. 
 
 
3.4.  Producing a Subject Bibliography 

 
Endnote lets you create a Subject Bibliography using the headings of your choice.  This can be useful 
if you want to create a reading list as a handout. 
 

• In Endnote open the Paleo Library 
 

• Select Subject Bibliography from the Tools menu 
 

• Highlight the fields you want to use for subject headings (in most cases this will be 
Keywords) and click OK 

 

• A single list of terms from the field(s) you selected will appear i.e. if you select Keywords a 
list of Keywords for the Paleo Library will be displayed 

 

• Select the terms you wish to include as subject headings 
 

• Click OK to format the bibliography on screen 
 

• You can edit the layout by clicking on the layout tab 
 

• When your Subject Bibliography is how you want it, choose print or save   
 
3.5.  Editing Output Styles 
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Output Styles are used to deal with in-text citations, footnotes citations and bibliographies for all 
reference types.  It identifies how to arrange information.  However, you will sometimes find that a 
particular style you use is not listed.  Therefore if you are clear on the style required, choose a close 
match and you can edit the style to your own requirements.  To edit an output style, follow the 
instructions below – 
 

• Select Edit – Output styles – Open Style Manager 

• Select a style to edit, e.g. Harvard, Quarterly Review Biology, BMC Cancer, American 
Historical Review 

• Click on the Edit button 

• Any changes you make to the style will be saved as a copy file. Endnote will call it e.g. 
Harvard Copy, but you can change its name to whatever you wish to call it. The original style 
will remain unaltered. 

• The Style window, displaying options for editing the style, is now displayed. 
 

 
 
 
 
 
 
 
 
 
 
 

 
• On the left-hand side of the screen you will see a list of options, you can click on any of these 

to find out more about the style 
 

• The templates look like citations or bibliography entries, except that field names are used in 
place of the actual data. During the formatting process, EndNote replaces the field names with 
the corresponding information from the references.   
 

• If you want to create an annotated bibliography you can modify your output style.  From the 
ensuing panel, select Layout under the Bibliography section. Click on the Insert Field button 
above “End each reference with:” and select Abstract (or Notes if you want to use your 
Notes field for annotation).  
 

NB:  Use of the Harvard Style at the University of Birmingham.  An amended version of the 
Harvard Style of referencing and bibliography has been adopted as the standard for the presentation 
of academic text at the University of Birmingham.  For detailed information and examples of how to 
use this version of Harvard please consult either the Skills Guide “Preparing and Quoting References 
using the Harvard System” or go to the i-cite guide at www.i-cite.bham.ac.uk and look under 
referencing.  You can download an output style for the version of Harvard used at this University from 
the i-cite guide and put it into your Endnote Styles folder.    
 
 

3.5.1  Editing the citations part of an Output Style 

 
Suppose you wish to change the in-text citation from author year to just author (or even the numbered 
sequence) or to have semi colons separating more than one author or to have 2 digit years rather than 
the full year range. To effect any (or all!) of these changes  
 

• Open the Edit menu for your chosen output style (ie the one you have just saved!) 

• Select Citations and then the templates heading  

• Insert your preference – change the options in the in-text citation template by inserting the 
cursor in the box or by ticking the year format box at the bottom of the screen.   

• Save the changes. You might like to check the other options available under the citations – 
template heading such as dealing with et al under Author Lists 

Image: Screenshot of Endnote, Style Manager 
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3.5.2  Editing the bibliography part of an Output Style 
 
Now lets change the display format by deleting and inserting as appropriate.  For example: 
 

• Again within your chosen style, select bibliography and then templates 
 

• Click in the Generic section of that panel. The elements will be listed in the format in which 
they will be displayed.  

 

• Change some elements around so that the place published and publisher or the year and 
volume are swapped around. Alternatively italicise or put in bold the title by highlighting the 
word title, then from the edit menu choose style and italic (or bold), etc 

 

• Save the changes 
 

• Open your library and choose Show Tab Pane from the bottom (right-hand side) of the library 
window. Select different references in your library to see how they format.  

 

• NB: Take a close look at title capitalization, the sort order of the references, and various other 
options provided in the style window. Other options such as Page Numbers, Journal Names 
and Anonymous Works can also be edited.  To edit these go to Edit, Output Styles and Edit 
the style.  You will see Anonymous Works, Page Numbers and Journal Names at the top of 
the Output Style Edit window.  

 
 

3.5.3.  Editing individual citations in a Word document 
 
There may be times when you want to change an individual citation. For example, you may want to 
remove the year or author from a citation or you may want to add a page reference before or after the 
citation. 

• Start Word and open your document 
 

• Insert some references into your document and format the citation in the style required. 
 

• In Word, click on the formatted citation e.g.  (Baker, 1988) 
 

• From the Endnote X4 tab, go to Edit Citation(s) 
 

• The Endnote Edit and Manage Citations dialog box is displayed 
 

• The cited references in the document are listed at the top of the dialog box. 
 

• Use the Edit Citation dialog box to make your alterations 
 
 
 
 
 
 
 
 
 
 
 

 
 

• Exclude Author:  Select this to omit the author name from the formatted citation 

• Exclude Year:  Select this to omit the date from the formatted citation 

• Prefix:  Enter text here to print immediately before the citation text 

Image: Screenshot of Endnote, Edit and Manager Citations dialogue box 
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• Suffix:  Enter text here to print after the citation.  You can enter page numbers here if you 
always want them to print after the citation. 

• Pages:  Page numbers entered here are considered entered into a “cited pages” field, so 
they can be manipulated on output just like any other Endnote field.  In order to print, the 
Cited Pages field must be listed in the citation template and/or footnote template of your 
output style. 

• Click OK to implement the change(s) to the citation  
 
 
3.7.  Copying between libraries 

 
Sometimes you will find it useful to copy some references from one library to another. 
 

• Open the libraries you want to copy to and from 

• Highlight some references you would like to copy (using Ctrl to select multiple references). 

• Use Edit and Copy to copy the selection from the first library, and Edit and Paste to 
download the references to the second library.  They will automatically interfile with the 
existing references there. 

 
 
3.8.  Printing directly from EndNote  

• Select some references  

• Choose the output style you would like to print your references in (using Edit and Output 
Style) 

• Click File, Print, OK 
 
 
 
4.  FURTHER HELP 
 
Further help with using EndNote is always available: 
 

• i-cite:  This is a website maintained by Library Services which provides links to useful pages 
which deal with all aspects of managing and citing references including identifying suitable 
filters for importing records from databases:  http://www.i-cite.bham.ac.uk/ 
 

• For help with more technical queries go to Adept Science Knowledge Database 
www.adeptscience.co.uk/kb  
 

• Subject support teams:  If you need individual help or advice about using EndNote in your 
work, please contact one of the members of the Academic Support Teams for your subject: 
http://www.library.bham.ac.uk/searching/subjectsupport   
 

• You can purchase EndNote software for loading onto your personal PC from the Learning 
Centre or directly from the supplier, AdeptScience at: http://www.adeptscience.co.uk.  To 
obtain a discount, click on the Education tab and log in where it says “Login Now” to enter the 
Adept Scientific Academic Software Store and search for the University of Birmingham and 
type in your University username and password. 

 
 
 

All Information Services documents are available in other formats.  
Please contact Library Services Direct on 0121 414 5828 or 

www.is.bham.ac.uk/lsd for information 
 

 

 


